## Contents

**What's New in Pro Tools | First 12.8.2** ................................. 1
  - New Features and Enhancements ............................................. 1
  - System Requirements and Compatibility Information ............ 2
  - Conventions Used in This Guide ............................................. 3
  - Resources ........................................................................... 4

**New MIDI Features and Improvements** ..................................... 5
  - MIDI Editing Enhancements .................................................. 5
  - MIDI Recording Improvements ............................................. 11

**Miscellaneous Enhancements** ................................................. 13
  - Convert Pro Tools Sessions to Pro Tools | First Projects .......... 13
  - New Keyboard Shortcuts and Modifiers ................................. 14
What’s New in Pro Tools | First 12.8.2

New Features and Enhancements

Pro Tools® | First version 12.8.2 provides the following new features and enhancements:

MIDI

MIDI Editing Enhancements

Tab to Transient Improvements with MIDI Data
- With Tab to Transients disabled, tab to MIDI clip boundaries in all track views
- With Tab to Transients enabled, tab to MIDI clip boundaries and MIDI notes in all track views
- With Tab to Transients enabled, tab to MIDI CC events in MIDI CC track views and shown controller lanes

Left and Right Arrow Key Navigate MIDI Notes in Notes View
- Move to and select previous (Left Arrow) or next (Right Arrow) MIDI notes in Notes view

Improved Smart Tool Behavior when Editing MIDI Clips
- Move and place end of MIDI clip to Edit Insertion point
- Move and place beginning of MIDI clip to Edit Insertion point
- Duplicate and place end of MIDI clip copy to Edit Insertion point
- Duplicate and place beginning of MIDI clip copy to Edit Insertion point

Grabber Tool Places the Edit Insertion Point at the Nearest Grid Location when in MIDI Notes View and in Grid Mode
This facilitates MIDI editing in Notes view with Grid mode enabled.

Clip Boundaries Shown in MIDI Control Automation Track Views
This provides visual navigation of MIDI clips while editing and arranging MIDI CC data.

MIDI Controller Numbers Shown in Track View and Controller Lane Selectors
This helps to ensure that you are editing the desired MIDI CC data.

Scroll Track Piano Roll with Scroll Wheel or Track Pad
This lets you quickly and easily view the appropriate register when editing MIDI notes.

MIDI Recording Enhancements

MIDI and Instrument Tracks Show Recording Progress
This provides a visual indication of recording progress on the timeline.

Recorded MIDI Clips Automatically Trimmed to the Nearest Barlines Containing All Recorded MIDI Data
This facilitates MIDI clip arranging.

MIDI Merge Release Mode for Improved MIDI CC Merge Recording
This ensures the proper merging of MIDI CC data with multiple record passes.
Miscellaneous Improvements

Convert Pro Tools Sessions (.ptx files) to Pro Tools | First Projects

Pro Tools | First can convert Pro Tools session files (.ptx) to Pro Tools | First projects. This lets you work with Pro Tools sessions you may already have as well as Pro Tools sessions you might have received from someone else.

Scroll to Track Names (Rather than Track Numbers)

This lets you quickly scroll to the desired track in the Edit or Mix window.

New Keyboard Shortcuts and Modifiers

- New keyboard shortcuts to adjust grid and nudge size without needing a numeric keypad
- Keyboard shortcut to show or hide the docked MIDI Editor in the Editor window
- Key modifier to switch Pencil Tool between the currently selected Line shape and the Free Hand option

System Requirements and Compatibility Information

Avid can only assure compatibility and provide support for hardware and software it has tested and approved.

For complete system requirements and a list of qualified computers, operating systems, hard drives, and third-party devices, visit:

www.avid.com/compatibility
Conventions Used in This Guide

Pro Tools documentation uses the following conventions to indicate menu choices, keyboard commands, and mouse commands:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>File &gt; Save</td>
<td>Choose Save from the File menu</td>
</tr>
<tr>
<td>Control+N</td>
<td>Hold down the Control key and press the N key</td>
</tr>
<tr>
<td>Control-click</td>
<td>Hold down the Control key and click the mouse button</td>
</tr>
<tr>
<td>Right-click</td>
<td>Click with the right mouse button</td>
</tr>
</tbody>
</table>

The names of Commands, Options, and Settings that appear on-screen are in a different font.

The following symbols are used to highlight important information:

💡 User Tips are helpful hints for getting the most from your Pro Tools system.

⚠️ Important Notices include information that could affect your Pro Tools project data or the performance of your Pro Tools system.

🔍 Shortcuts show you useful keyboard or mouse shortcuts.

unlink Cross References point to related sections in this guide and other Avid documentation.

How to Use this PDF Guide

This PDF provides the following useful features:

- The Bookmarks on the left serve as a continuously visible table of contents. Click on a subject heading to jump to that page.
- Click a + symbol to expand that heading to show subheadings. Click the – symbol to collapse a subheading.
- The Table of Contents provides active links to their pages. Select the hand cursor, allow it to hover over the heading until it turns into a finger. Then click to locate to that subject and page.
- All cross references in blue are active links. Click to follow the reference.
- Select Find from the Edit menu to search for a subject.
- When viewing this PDF on an iPad, it is recommended that you open the file using iBooks to take advantage of active links within the document. When viewing the PDF in Safari, touch the screen, then touch Open in “iBooks”.
**Resources**

The Avid website ([www.avid.com](http://www.avid.com)) is your best online source for information to help you get the most out of Pro Tools.

**Account Activation and Product Registration**

Activate your product to access downloads in your Avid account (or quickly create an account if you do not have one). Register your purchase online, download software, updates, documentation, and other resources.

[www.avid.com/account](http://www.avid.com/account)

**Support and Downloads**

Contact Avid Customer Success (technical support), download software updates and the latest online manuals, browse the Compatibility documents for system requirements, search the online Knowledge Base or join the worldwide Avid user community on the User Conference.

[www.avid.com/support](http://www.avid.com/support)

**Training and Education**

Study on your own using courses available online, find out how you can learn in a classroom setting at an Avid-certified training center, or view video tutorials and webinars.

[www.avid.com/education](http://www.avid.com/education)

**Products and Developers**

Learn about Avid products, download demo software, or learn about our Development Partners and their plug-ins, applications, and hardware.

[www.avid.com/products](http://www.avid.com/products)
New MIDI Features and Improvements

MIDI Editing Enhancements

Using Tab to Transients with MIDI Clips and MIDI Events

Tab to Transients works with MIDI clips and MIDI events on MIDI and Instrument tracks much like it does with audio clips and audio transients on audio tracks.

Tab to Transients Disabled

When Tab to Transients is disabled, pressing Tab moves the insertion point to the next MIDI clip boundary regardless of the track view (just like with audio clips).

Tab to Transients Enabled

When Tab to Transients is enabled, pressing Tab moves the Edit insertion to the beginning of the next note or clip boundary regardless of the track view (just like with audio transients), but does not make note selections.

Press Option+Tab (Mac) or Alt+Tab (Windows) to move the insertion point to the previous clip boundary or MIDI event.
Tabbing to Notes and MIDI CC Events in Notes View with Controller Lanes Shown

When a MIDI or Instrument track is set to Notes view and Tab to Transients is enabled, press the Tab key to move to the next MIDI note or MIDI CC event (such as MIDI CC 64 Sustain Pedal) shown in a revealed controller lane. Press Option+Tab (Mac) or Alt+Tab (Windows) to move to the previous note or MIDI event.

Hold the Shift key while pressing Tab—or Option+Tab (Mac) or Alt+Tab (Windows)—to move the insertion point and make or extend the edit selection.

Command Focus L and Command Focus “Apostrophe” (‘) function the same as with Option+Tab (Mac) or Alt+Tab (Windows) and Tab with Tab to Transients is enabled or disabled.

Tabbing to MIDI CC Events in MIDI CC Track Views

When a MIDI or Instrument track is set to any MIDI Controller track view and Tab to Transients is enabled, press the Tab key to move to the next MIDI event shown in that track view. Press Option+Tab (Mac) or Alt+Tab (Windows) to move to the previous MIDI event.
Navigating MIDI Notes with the Left and Right Arrow Keys

Navigating Notes

In Notes view, use the Left and Right Arrow keys to navigate to and select the previous or the next note.

![Image of navigating notes](image1)

In Notes view, moving from one note to the next using the Right Arrow key

💡 For MIDI and Instrument tracks in Notes view where any MIDI Controller lanes shown, the Left and Right Arrow keys only navigate through MID notes and skip all MIDI CC events shown in any Controller lane.

Selecting Notes

Hold the Shift key while using the Left and Right Arrow keys to extend the note selection.

![Image of selecting notes](image2)

In Notes view, selecting notes using the Right Arrow key while holding the Shift key

Navigating and Selecting Notes in Chords

When navigating through chords with the Left and Right Arrow keys, each note in the chord is recognized as a single event. This lets you move through each note in the chord, selecting each individually.

![Image of navigating chords](image3)

In Notes view, navigating the notes of a chord with the Right Arrow key
Use the Shift key with the Left and Right Arrow keys to select more than a single note in a chord.

**Improved Smart Tool Behavior when Editing MIDI Clips**

When editing MIDI clips with the Smart tool, you can position the Smart tool over the lower half of the clip to use the Grabber tool. If you position the Smart tool over the lower third of the clip, you can use the Grabber tool with key modifiers to place either the beginning of the clip or the end of the clip to the Edit insertion point. You can also do this when duplicating MIDI clips.

**To move and place the beginning of a MIDI clip to the Edit insertion point:**

1. Set the Edit insertion point to the location you want.
2. With the Smart tool, position the cursor over the lower third of the clip. The Grabber tool cursor appears.
3. Control-click (Mac) or Start-click (Windows) and drag the clip toward the Edit insertion and release the mouse.

The beginning of the clip snaps to the Edit insertion point.
To duplicate a MIDI clip and have the copy start at the Edit insertion point:
1. Set the Edit insertion point to the location you want.
2. With the Smart tool, position the cursor over the lower third of the clip you want to duplicate and place. The Grabber tool cursor appears.
3. Option-Control-click (Mac) or Alt-Start-click (Windows) and drag the clip toward the Edit insertion and release the mouse.

The duplicate of the clip starts at the Edit insertion point.

To move and place the end of a MIDI clip to the Edit insertion point:
1. Set the Edit insertion point to the location you want.
2. With the Smart tool, position the cursor over the lower third of the clip. The Grabber tool cursor appears.
3. Command-Control-click (Mac) or Control-Start-click (Windows) and drag the clip toward the Edit insertion and release the mouse.

The end of the clip snaps to the Edit insertion point.

Snapping the end of a MIDI clip to Insertion point with the Smart tool

To duplicate a MIDI clip and have the copy end at the Edit insertion point:
1. Set the Edit insertion point to the location you want.
2. With the Smart tool, position the cursor over the lower third of the clip you want to duplicate and place. The Grabber tool cursor appears.
3. Command-Option-Control-click (Mac) or Control-Alt-Start-click (Windows) and drag the clip toward the Edit insertion and release the mouse.

The duplicate of the clip ends at the Edit insertion point.
Grabber Tool Places the Edit Insertion Point at the Nearest Grid Location when in Notes View and in Grid Mode

When in Grid mode and in Notes view on MIDI and Instrument tracks, clicking anywhere in the timeline outside of a clip with the Grabber tool places the Edit insertion point at the nearest grid location.

Press Command (Mac) or Control (Windows) while clicking with the Grabber tool in notes view temporarily toggle to Slip mode.

Clip Boundaries Shown in MIDI Control Automation Track Views

When working on Instrument and MIDI tracks in any MIDI Controller Automation view (such as Velocity, Pitch Bend, or Mod Wheel) Clip boundaries are displayed. This provides context for note and MIDI Controller data visible on the track as you are editing. MIDI clip boundaries are also shown in MIDI Editor windows. This is useful for navigating various MIDI views when editing and arranging MIDI clips and MIDI data.

MIDI Controller Numbers Shown in Track View and Controller Lane Selectors

MIDI Continuous Controller (CC) numbers are shown in parenthesis in the Track View and Controller Lane selectors. Aside from common controller number assignments like “Mod Wheel” (1), “Volume” (7), or “Sustain Pedal” (64), many MIDI continuous controllers are simply “unassigned” in the standard MIDI specification. This can be confusing if you are editing data for several “unassigned” or otherwise generic continuous controllers, so by having the controller number always shown next to the name in parenthesis, you can easily see which continuous controller you are editing.
**Scroll Track Piano Roll with Scroll Wheel or Track Pad**

Use the scroll wheel on your mouse or the track pad on your laptop to scroll the piano roll up or down on a MIDI or Instrument track to view the note range you want to work with. This is a quick and easy way to focus the track on the right register for note editing.

**To scroll the piano roll of a MIDI or Instrument track up or down:**

1. In the Edit window, position the cursor over the piano roll of the MIDI or Instrument track you are working with.
2. Use the scroll wheel or track pad (two-finger scroll) to scroll up or down until you locate the register you want.

---

**MIDI Recording Improvements**

**MIDI and Instrument Tracks Show Recording Progress**

When recording MIDI on a MIDI or Instrument track, Pro Tools displays an advancing red clip to indicate recording progress against the timeline (just as when recording audio on an audio track).
Recorded MIDI Clips Automatically Trimmed to the Nearest Barlines

When recording MIDI to a MIDI or Instrument track, the resulting clip is trimmed to the nearest bar line. The new clip contains all recorded MIDI data and automatically adjusts its start and end points to fit into the fewest number of whole bars for the recorded performance. This facilitates bar-based editing and arranging with recorded MIDI clips.

MIDI Merge Release Mode

MIDI Merge Release Mode provides three options for how Pro Tools | First writes MIDI Continuous Controller (CC) automation when recording MIDI in MIDI Merge mode. These options determine how MIDI CC data (such as the Sustain Pedal: MIDI CC 64) is written after release (pedal up). Select the desired MIDI Merge Release Mode option from the Right-click menu on the MIDI Merge button. Select the appropriate option according to your workflow:

**Latch** Continues writing the last value. Any existing events are overwritten until you stop recording.

**Latch Until Next Event** Continues writing the last value until the next event even if you are still recording.

**Touch** Immediately stops writing any new values (only use this mode to add pedal-based control data, not to modify existing data).

To set the MIDI Merge Release Mode in the Edit window or the Transport window:

1. Ensure that the MIDI Controls are shown.
2. Right-click the MIDI Merge button and select the desired option.

![MIDI Merge button Right-click menu](image)
Miscellaneous Enhancements

Convert Pro Tools Sessions to Pro Tools | First Projects

Pro Tools | First lets you convert Pro Tools session files (.ptx) to Pro Tools | First projects.

To convert a Pro Tools session to a Pro Tools | First project:

1. Launch Pro Tools | First and log in to your Avid Master Account.
2. Do one of the following:
   - If the Dashboard is not open, choose File > Convert Session.
   - In the Pro Tools | First Dashboard, click the Convert Session button.

3. Navigate to and select the Pro Tools session (.ptx) you want to convert.
4. Click Open.
5. In the Create Project dialog, name the project (if you want to name it something different from the session).
6. Click Create.

Pro Tools | First converts the session into a project and uploads a copy of all project data and media to your Avid Cloud Storage Account as well as caching it locally.
New Keyboard Shortcuts and Modifiers

Keyboard Shortcuts for Adjusting Grid and Nudge
Use the following keyboard shortcuts to adjust the grid and nudge values on any computer keyboard (such as laptop computers):

To increase the grid value:
- Press Shift+Equal (=)

To decrease the grid value:
- Press Shift+Minus (–)

To increase the nudge value:
- Press Shift+Option+Equal (=) (Mac) or Shift+Alt+Equal (=) (Windows)

To decrease the nudge value:
- Press Shift+Option+Minus (–) (Mac) or Shift+Alt+Minus (–) (Windows)

Keyboard Shortcut to Show/Hide the MIDI Editor
Pro Tools | First lets you show or hide the MIDI Editor docked in the Edit window with a keyboard shortcut.

To show or hide the MIDI Editor in the Edit window:
- Press Shift+Option+Control+"=" (Mac) or Shift+Alt+Start+"=" (Windows).

Key Modifier to Switch Pencil Tool Between Selected Line Shape and Free Hand Options
When editing automation or MIDI control data with the Pencil tool, you can switch between the current Pencil Tool shape (such as Line) and Free Hand pencil editing using a key modifier: the Command key (Mac) or the Control key (Windows). When editing with the selected Pencil shape, the Pencil cursor angles to the left. When editing in Free Hand with the key modifier, the Pencil cursor angles to the right.

To temporarily switch to Free Hand editing with the Pencil tool:
- Press the Command key (Mac) or the Control key (Windows) while editing with the Pencil Tool.

Release the key modifier to switch back to editing with the selected Pencil shape.

Editing with Triangle Pencil tool (left), editing in Free Hand using key modifier (right)